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Customizing the User Interface

You can customize the Axiom Software user interface by creating custom task panes and custom ribbon
tabs, and then assigning them to users and roles. Many of the built-in task panes and ribbon tabs can
also be customized, including the main Axiom ribbon tab.

Generally speaking, the creation of custom task panes and ribbon tabs is an administrator function. The
intent is for administrators or other power users to create the custom task panes and ribbon tabs as
needed for their end users, and then assign these items as startup files in Axiom Software Security.
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About custom task panes and ribbon tabs

Using custom task panes and ribbon tabs, you can provide your users with a user interface designed
especially for them.

Defining custom task panes and ribbon tabs

Task panes and ribbon tabs are stored as AXL files in the Task Panes Library and in the Ribbon Tabs
Library respectively. Task panes and ribbon tabs are created in a very similar manner. Both use a multi-
level structure, with top-level "sections" that can contain one or more child items.

o Inthe task pane environment, the top-level section is displayed as a gray header bar which can be
collapsed and expanded to access the child items in the section.

o Intheribbon environment, the top-level section is displayed as a ribbon group, and the child
items in that section display as buttons in the group.

The following example shows how the same basic structure is rendered as a ribbon tab and as a task
pane.

Axiom Sottware - lrair
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AXIOM EXAMPLE Home
=> GoTo Location ':.."_‘_--Re."er Workbook
_w | iG]Change View = | €z Quick Filter

~ Navigation -~ Example structure

= GoTo Location - displayed as aribbon tab

Change View
* Data
. N ¢ Axiom Assistant
" Refresh Workbook T -
T avigation ~
(' Quick Filtar ——

LR =» GoTo Location
b '_': E:Char‘.c_;e View

Explorer

Example structure with two sections Data

?’-Refresh Workbook

2 Quick Filter
Example structure
displayed as a task pane

Example

Task panes and ribbon tabs can contain the following items:

o Links to file groups, files, and folders in Axiom Software, so that users can open these items from
the task pane or ribbon.

o Various Axiom Software feature commands from the Command Library, so that users can launch
the feature from the task pane or ribbon.

o Plain text items for header and group titles, and for instructional text (such as in a task pane that
provides instruction for a process).

Security permissions apply to all items in task panes and ribbon tabs. If a file or feature is placed in a task
pane or ribbon tab, but a particular user does not have the appropriate security permissions for that
item, then that user will not be able to use that item. The item will either be hidden or it will display as
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grayed out, depending on whether the Show restricted item option is enabled for that item in the task
pane or ribbon tab.

Common uses of custom task panes and ribbon tabs

The most common use of custom task panes and ribbon tabs is to provide users with a custom user
interface. For example, you may want to streamline the user interface so that end users only see the
specific Axiom features that they need to use. You can do this by customizing the "built-in" Axiom ribbon
tab, and/or by creating and assigning additional custom ribbon tabs and task panes to users and roles.

For example, some customers might want to create a very simple version of the Axiom ribbon tab for
their end users, something like the following:

AXICOM Home

E Save |_ Refresh Data - 0 Help T Close Axiom Software
I@ Change Wiew ~ E‘I'.-i-:d Rowis) = ﬁ About Axiom EPM

= GoTo Location -

End user roles could be assigned this simple ribbon tab, while administrators and power users continue
to use the default Axiom ribbon tab. Notice in this example that no file groups are listed on the ribbon
and there's no Reports button—this sort of design would depend on users accessing their plan files and
reports via links on the Home page, or by using the Explorer task pane or a custom task pane. This
example is intentionally very simple to illustrate the full range of possibilities between the default ribbon
tab and a minimal one.

Other typical uses include:

o Providing easy access to certain files, such as a list of frequently-used reports. This list could be
presented in a reporting task pane so that users do not need to navigate the Reports Library to
access these reports.

o Providing user instruction for various processes. For example, you could provide a task pane that
walks the user through the steps needed to open their plan file, edit their plan file, and then
submit their plan file for review.

NOTE: Custom task panes do not provide full process management; they are intended more
as a casual guide for users. If you want to define a process with enforced task order and
ownership, including an audit trail for when a task was completed and by whom, then you
should use the Process Management feature.

The following is an example task pane that could be made for end users to complete their budgets.
Although it would be possible to do this as a ribbon tab, use of text instruction for a process is better
suited for a task pane.
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The next example task pane would be intended for administrators and other finance "power users." It
collects all of major files and utilities that these users need to manage the budget process.

£ Axiom Assistant

Glohal Drivers ~

1 Review Actuals
2 Enter Global Assumptions
¥ GlobalDrivers
1y Region1Drivers
Departmental Budget &

Explorer

1 Budget Input

b 2 Financial Reports

Finalize Budget s
1 Balancing Utility
2 Allocations

Process

Reports &
E-l_:] Financials
E-l_:] Cost Center Comparison
E-l_:] Crganizational Variance
@_ﬂr-".cc ount Variance

Budget X

Assigning custom task panes and ribbon tabs to users and roles

The primary method of using custom ribbon tabs and task panes is to assign them as startup files in
Axiom security to certain users and roles. When a custom ribbon tab or task pane is assigned as a startup
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file, then it automatically opens when the user starts Axiom Software.

Axiom Software provides certain "built-in" custom task panes and ribbon tabs that are automatically
assigned to the Everyone role by default, such as the Axiom ribbon tab or the Explorer task pane. You
can use these built-in items as is, or you can customize them as desired and change their security
configuration. For more information, see Built-in task panes and ribbon tabs.

For task panes only, you can also choose to give users and roles direct access to certain task pane files in
the Task Panes Library (by granting permission on the Files tab of Axiom security). These users can then
open these task panes "on demand" as needed. This is a good option for task panes that only need to be
used occasionally rather than all the time. Ribbon tabs cannot be used in this way because the contents
of the ribbon are determined at startup. It is not possible to open a ribbon tab in the ribbon "on
demand".

For more information, see Assigning ribbon tabs to users and Assigning task panes to users.

Task panes

You can use custom task panes to provide users with a custom user interface in the Excel Client or the
Windows Client. For an overview of how the Axiom user interface can be customized, see About custom
task panes and ribbon tabs.

This section explains how to create, edit, and delete custom task panes, and then assign them to end
users. Task panes are managed using the Task Panes Library within Axiom Explorer. Task pane files

display using the task paneicon II__l

In addition to creating your own custom task panes, you can customize the built-in task panes provided
by Axiom Software, such as the Explorer task pane, the Workflow task pane, and the Process task pane.
For more information, see Built-in task panes and ribbon tabs.

NOTE: It is also possible to use an Axiom form as a task pane. In this case, the Axiom form displays
within the task pane area and is considered a "dialog" for behavior purposes (such as for storing and
sharing "form state" values). For more information, see the Axiom Forms and Dashboards Guide.

Task pane editor

You can create and edit custom task panes using the Edit Task Pane dialog. This dialog has three sections
as shown in the following example screenshot.
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The middle section, labeled Task Pane Structure, is where you define the sections and individual items to
display in the task pane. To add new items to this structure, you can either:

e Usethe Add New Item button in the toolbar to add new items. You can choose to add a new child
item to the currently selected item, or add a new item at the same level, or add a new section-level

item.

o Use the right-click menu to add new items. This has the same options as the Add New Item

button.

o Dragand drop an item from the Axiom Explorer pane (the left-hand section of the dialog) to the
desired location in the task pane structure. This will automatically link the item in the task pane
structure to the appropriate feature or file (based on what you dragged and dropped).

When you select an item in the task pane structure, the properties for that item display in the right-hand
section of the dialog, labeled Selected Item Details. Here you can define display text and other display
properties for each item, and assign the associated feature or file for the item using the Shortcut Target.
(When you drag and drop and item from the Axiom Explorer pane to the task pane structure, the
shortcut target is automatically assigned.) For more information on the available properties, see Task

pane properties.

You can move items in the task pane structure by dragging and dropping them to various locations, or
by using Copy or Cut and then Paste. To remove an item, select it and then click Delete. Any child items
of the item you deleted will also be deleted.

Customizing the User Interface
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The task pane editor is not a full WYSIWYG editor. After creating a task pane, you should make sure to
open and review the task pane in the Axiom Assistant area to ensure that it displays as you intended.

TIP: If you need to edit an existing task pane, you can first open the task pane in the Axiom Assistant
area and then open the task pane file for editing. As you make changes in the editor, you can click
Apply to see the change reflected in the currently open task pane.

Managing task panes

Task panes can be created, edited, or deleted using Manage > Task Panes, in the Administration group
of the Axiom tab. You can also manage task panes from the Task Panes Library in the Explorer task pane.

Creating a task pane

You can create task panes for various purposes and display them to users within the Axiom Assistant
area. Once a task pane is created, it can be assigned to users and roles to open automatically when the
user logs into the system, or to be available to open on demand.

Task panes consist of one or more section headers and child items within the section. The section
headers display as gray bars that can be used to expand or collapse the section. Child items can be used
to display instructional text or to link to files and features.

NOTE: Only administrators and users with the Administer Task Panes security permission can create
new task panes.

To create a new task pane:
1. Onthe Axiom tab, in the Administration group, click Manage > Task Panes.

The Axiom Explorer dialog opens, with the focus on the Task Panes Library. You can also access
this library using the Explorer task pane.

TIP: If you already have a custom task pane open in the Axiom Assistant area, you can right-
click the tab of the task pane and select Create New Task Pane.

2. Right-click the Task Panes Library, and then select New > Task Pane.
The Edit Task Pane dialog opens.

3. New task pane files start with a single section header, named Sectionl. Edit the name of this
section using the Section name box in the right-hand side of the dialog.

You can configure other appearance details for this section, such as to define an optional tool tip,
or to enable auto-numbering or image display for this section's child items. For more details on
the available options, see Task pane properties.

4. Add child items to the section as needed. You can add child items by doing any of the following:
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o With the section name selected, click Add New Item > Child of selected item.

o With a child item selected, click Add New Item and then either Before selected item or
After selected item.

o Dragand drop an item from the Axiom Explorer pane in the left-hand side of the screen to
the desired place in the task pane structure. A black line shows you where the item will be
placed.

You can configure each item as desired. An item can be just display text for instructional purposes,
or you can link the item to an Axiom file or feature. If you dragged and dropped an item from the
Axiom Explorer pane into the task pane structure, then the item is automatically linked to that file
or feature. Otherwise, use the Shortcut Target setting to assign the item to a file or feature.

For more information on the types of files and features that can be included on task panes and
how they work, see Linking to Axiom files and features in a task pane or ribbon tab. For more
details on available appearance properties, see Task pane properties.

NOTE: If an item has child items, then it cannot also have a shortcut target. When users
interact with the task pane, double-clicking an item with children expands and collapses the
item, so there is no way for the user to launch the shortcut target in this case.

There are a variety of ways to configure task panes. For more details on some common design
goals and avoiding potential issues, see Task pane design considerations.

5. Add more sections and child items as needed. You can add new sections by using Add New Item >
New top level section. Arrange these items as desired by dragging or dropping items within the
structure, or by using the Edit button to cut, copy, and paste.

6. Click OK to save.

The Save As dialog opens to the Task Panes Library. Give the file a name and optionally a
description, and save it to the desired location.

NOTE: The name of the task pane file determines the default name of the task pane tab within
the Axiom Assistant area. For example if the file is named Reports, then when it is opened as a
task pane it will have a tab name of Reports. Make sure the file name is brief and intuitive.

After you have created a new task pane, you should open it to make sure all items display and behave as
expected. If the task pane will be assigned to end users, it is a good idea to log in as a representative end
user and test it.

Editing a task pane

You can edit a task pane at any time, regardless of whether it is currently open in the Axiom Assistant
area. Task panes within the Axiom Assistant area are always open read-only and do not impact editing
availability. (If a message tells you that a task pane file is locked, this means that another user has
opened the task pane in the editor, not that the task pane is open in the Axiom Assistant area.)

If you are editing a task pane, the changes will be visible in your session right away, but other users will
not see the changes until the next time the task pane is opened. This means that if a task pane is
configured to open on startup, users will not see the changes until the next time they launch the system.
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To edit a task pane:
1. Do one of the following to open the task pane for editing:

o Ifthetask paneis already open in the Axiom Assistant area, right-click the tab and then
select Edit Task Pane.

TIP: One advantage of having the task pane open while editing is that you can click
Apply to immediately see the results of your edits, without needing to close the editing
dialog.

o From the Axiom tab, in the Administration group, click Manage > Task Panes. In the Task
Panes Library, navigate to the task pane that you want to edit, then right-click it and select
Edit. You can also perform this action from the Explorer task pane.

2. Inthe Edit Task Panes dialog, edit the task pane as desired. For more information on the available
task pane properties, see Task pane properties.

3. Click Apply or OK to save the task pane. If you would rather save this task pane as a new file, you
can click File > Save As from the dialog toolbar.

Deleting a task pane

You can delete a task pane at any time. However, if the task pane is currently open in the Axiom Assistant
area within your session, you must first close it before the file can be deleted. It does not matter if the
task paneis opened in other users' sessions—this does not prevent deletion.

If the task pane is a startup task pane that is configured to be non-closeable, then you must first remove
or modify the startup configuration so that you will be able to close it. After you have modified the
applicable startup configuration in Security, exit the system and then log in again to apply the new
startup configuration.

If any other users currently have the task pane open when you delete the file, the task pane will remain
useable in that session until the user closes the task pane or exits the system. If the deleted task pane
was configured to open on startup, no special steps are required to remove it from user configurations—
the next time users log in, the task pane will simply no longer exist and therefore will be ignored by the
startup configuration. However, it is a good idea to remove the obsolete configuration from Security so
that user configurations match what you expect to be displayed.

To delete a task pane:

1. From the Axiom tab, in the Administration group, click Manage > Task Panes. You can also delete
task panes using the Explorer task pane.

2. Inthe Task Panes Library, navigate to the task pane that you want to delete, then right-click and
select Delete.

Task pane design considerations

Keep in mind the following design considerations when creating task panes.
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Creating task panes with multiple sections

All top-level items in a task pane are automatically section headers. These items display using a gray
header bar, and can be expanded and collapsed (by default, they display expanded).

If the task pane only needs one section, then the task pane should be created so that all items are
children of a single top-level item. The following screenshot shows an open task pane with one header
side-by-side with the associated view in the editor.

< Axiom Assistant © Edit Task Pane:
Completing Your Budget = File = E® Edit ~ # Add New item ~ < Delete

e 1 Open your plan file(s) Axiom Explorer ; \ Task Pane Structure
‘5‘ » € 2 Complete Budget sheet = 1 O.ne top-levelitem  * i
= © 3 Complete Payroll sheet File Groups in the structure ~ Completing Your Budget
- H 4 Save file ¥ File Group definition ¥=] Open your plan file(s)

lz‘_",] 5 Run Budget Comparison report [ Budget 2015°

. — » € Complete Budget sheet
2 b iz Budget 2016
8 A S b 5] Budget 2017 € Complete Payroll sheet
S One section » VT Capital Requests EH save file
header in the ¥ VT Initiatives

(=) .
task pane 24 Run Budget Comparison report

stion

Libraries o
If the task pane needs multiple sections, then you can add multiple top-level items, and then add child

items to each section as needed. The following screenshot shows an open task pane with multiple
headers side-by-side with the associated view in the editor.
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T Axi lorec Task P. t
8 @j Budget instructions 200K 2 ?m _ = Ee-hane Structure
£ Completing Your Budget - File Grou  Multiple top-level w |7 Instructions
Open your plan file(s) ¥ e File items in the_ B Watch training video
v €} Complete Budget sheet v i=eug  Structure definition & . .
2l @Pa}-:cll sheet » ) Budd ®] Budget instructions
= Hsavefile y = 017 ~ Completing Your Budget
=] =] Budget 20 pleting
= RESJONS - » V=] Capital Requests ¥Z1 Open your plan file(s)
[Eh] Budget Comparison » V2 Initiativ
3 \ A Intinthes * € Complete Budget shest
= - o Libraries - * & Payroll sheet
E Multiple section » ] Reports Library =
headers in the » [ Table Library =1 Save file
task pane &5 Data Diagrams Library * Reports
¥ g Task Panes Library @) Budaet Comparison

* ['d Ribbon Tabs Library

Shortcuts on items with children

Shortcuts cannot be defined on items in a task pane that have child items. When an item has child items,
double-clicking the parent item expands or collapses the item—therefore, there is no way to launch the
associated shortcut for that item.

The task pane editor does not prevent saving a task pane with this configuration, however, it does
display a validation message informing you that an item cannot have both a shortcut and child items.

If you want to link to a file or feature and include associated instructional text, the shortcut should be
defined in the child items, not on the parent item. For example:
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Menthly Process

= |Import monthly actuals
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L. 2 Run GL Monthly Actuals impeort

In this example, the parent item serves as a statement of what to do, followed by instructional text and
then the link to the import.

Forcing display of an item

By default, if an item in a task pane links to a file or feature, and the user viewing the task pane does not
have access to that file or feature, then the item does not display in the task pane for that user. This
allows you to create task panes that are dynamic by user—you can include a full set of items in the task
pane and users will only see the items that apply to them.

Items in a task pane are also hidden if they do not apply to the current context. For example, an item
that links to the Add Rows command is hidden by default if the current file is a report, because that
command cannot be used in reports.

However in some cases you may want all items in a task pane to display, regardless of whether a user has
rights to the items, and regardless of whether the item applies to the current context. For example, you
may be creating a task pane that documents a particular process, and all of the process steps are
numbered. If a user does not have rights to the file linked in step 5, then step 5 will be omitted from the
task pane. Although the auto-numbering will be adjusted for the omitted item, you may prefer to include
the item in the task pane anyway for one or more of the following reasons:

o The omitted step may be required, and the user needs to know that it is there and that they

cannot perform it as is. Perhaps the user needs to wait for someone else to perform that step, or
maybe the security settings have been made in error and the user should have access to that file.

o The omitted step may be optional, but you still want the user to see its place in the overall
process. Users with the appropriate rights can perform the step, and users without rights can
simply move on to the next step.

To force an item to display in a task pane regardless of security settings or current context, enable Show
restricted item in the Display Settings for the item. This must be selected on a per item basis.

If this option is selected and a user does not have access to the linked item, or the item is not applicable
to the current context, then the item is grayed out in the task pane.

Displaying child items inline

If an item has child items, you can choose to display those items inline (at the level of the parent item),
omitting the display of the parent item. To do this, you must enable Display child items inline for the
parent item.

This behavior applies even when the child items are not defined in the task pane structure, but are
dynamically generated as part of the parent item. For example, if you link a task pane item to a report
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folder, the folder is the parent and the files in the folder are the child items, even though the child items
aren't technically defined in the task pane structure.

In this example task pane structure, the task pane item links to a report folder, and the item is configured
to display child items inline:

Task Pane Structure Selected Item Details

* Display inline example Display Text
Budget Reporis Inline e
Tool Tip

Custom Image

Display Settings

Display child item images
[] Auto-number child itemns
Display child items inline
[ ] Show restricted item

Shortcut Target
felder:/M\Axiom\Reports Librany\Budget Reparts. . &

The following screenshots show the difference in how this item displays, depending on whether Display
child items inline is enabled.

Display inline example ~ Display inline example
Izﬁ;’-‘l.cr:t Subtotals - Budget Reports
Eh Budget Comparisan (Eh] Acct Subtotals
@ Dept Subtotals (] Budget Comparisan
(=] Dept Subtotals

IzﬁDynamirz Ranges stacked

E Income Statement By Maonth
@Mnnthly report package
IzﬂTl’E out monthly data

=l Variance by Account_neste

(=] Dynamic Ranges stacked
EH Income Statement By Manth
@Manthly report package
|z|_1TiE out ronthly data
Izﬁ]‘\."ariance by Account_nested

Display child items inline: Enabled Display child items inline: Disabled

In the first example, the parent item does not display, and instead the child items display at the same
level of the parent item. In the second example, the child items display as normal under the parent item.

This setting is also useful when including pre-built feature controls in a custom task pane, such as the
Axiom Explorer Tree View. If you link a task pane item to the control, then by default the control will
display as a child item underneath the parent item. If instead you want the item to display directly within
the task pane, omitting the parent item, then select Display child items inline.

Customizing the User Interface Axiom Software | 12



Customizing the User Interface

For example, the following task pane item is linked to the Axiom Explorer Tree View control, configured to
show only the My Files section and configured to display child items inline.

Task Pane Structure Selected ltem Details
My Files Test Section name
My Files Test
Tool Tip
Display Settings

Display child item images
[] Aute-number child items
Display child items inline

Shortcut Target

command:/fAxiomExplorerTreeViewldds |, W

Shortcut Parameters

My Files Show
File Groups Hide -
Libraries Hide *

Axiom System Folder | Hide *~

The following screenshots show the difference in how this item displays, depending on whether Display
child items inline is enabled.

My Files =g My Files Test o
b 3 Favorites My Files ~
b il Recent

¥ 4 Favorites

b My Documents b =l Recent

b My Documents
Display child items inline: Enabled

Display child items inline: Disabled

In the first example, the My Files control is displayed directly within the task pane, omitting the parent
item. This is most often the preferred way to display a pre-built feature control. In the second example,
the My Files control is displayed underneath the parent item, which results in a duplicate header.

Embedding a task pane within another task pane

Itis possible to create "nested" task panes, where the content from one task pane displays within
another task pane. This is accomplished by using the shortcut property Embed list items when linking to

Axiom Software | 13



the task pane, and then optionally also enabling Display child items inline for the linked item.

NOTE: If Embed list items is enabled, then the contents of the embedded task pane are treated as if
they are part of the current task pane. Axiom Software does not make a separate security check to
see if the user has permission to access the embedded file—the user's permission to the current file is
all that matters. However, security permissions will be applied to the contents of the embedded task

pane as normal.

For example, imagine that you have a task pane, and you want to create a second task pane that has the
same content as the first task pane plus some additional items. If you link to the first task pane from the
second task pane, by default the first task pane will display as a file within the second task pane, and
users can double-click the file to open the first task pane. But if you instead enable Embed list items,
then the contents of the first task pane will display embedded within the second task pane.

Task Pane Structure

* Instructions
B Watch training video
@_] Budget instructions
* Completing Your Budget
ey Cpen your plan file(s)

* € Complete Budget sheet another task
r & Payrall sheet pane file

H save file _"'

L4

Reports Embedded

Enable this to display
contents of linked task
pane within this task pane

| ltem linked to

(7

J

— Embed list items

Definition example for nested task panes

Selected ltem Details

Section name
Reports

Tool Tip

Display Settings

Display child item images
[] Auto-number child items
[ Display child items inline

Shortcut Target

document:/MAxiom\Task Panes Libran/\Us

Shortcut Parameters

Axiom Tab Mame

At this point the items display as a collapsible node, with the name of the first task pane as the "parent"
item and the contents of the first task pane as child items.
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Instructions

&) Watch training video
1] Budget instructions
Completing Your Budget
Cpen your plan file(s)
r © Complete Budget sheet
r © Payrall sheet
E Save file

Reports

r ﬂ Maonthly Reports
r ﬂ Tie-Cut Reports

Ifinstead you want the contents of the first task pane to display inline within the second task pane (as if
they were defined directly within the second task pane), then you must also enable Display child items
inline for the linked item in the second task pane.

Instructions

B Watch training video
W] Budget instructions
Completing Your Budget
Cpen your plan file(s)
» © Complete Budget sheet
» © Payrall sheet
E Save file

Menthly Reports -
@ Create Region package
@ Budget to actuals

Tie-Out Reports
|z|_]T|'E aut menthly data
(=] Tie out budget data

NOTE: If you embed a task pane in another task pane, and you plan to assign the "parent" task pane
to users as a startup file, keep in mind that users must have explicit permission to the embedded
task panein order for it to display in the startup task pane. The implicit permission that results from
startup file assignment only applies to the parent task pane.

Task pane properties

The following properties are available for items in a task pane. If you are editing one of the built-in task
panes (such as Explorer), see the following for more information on that task pane: Built-in task panes
and ribbon tabs.
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Item Description

Display Text / The text to display for the item. If the item has a defined shortcut target to an
Section Name Axiom file or feature, then you can leave this box blank, and the display text will
be the name of the file or feature.

If the item is a top-level item, then this property is called Section Name, to
indicate that the item will be displayed as a section header in the task pane.
Section headers are gray title bars that can be expanded and collapsed.

Tool Tip The text to display as a tool tip when a user hovers their cursor over the item.
This text can be helpful to explain the purpose of the item within the context of
the list.

If no tool tip text is defined, then the tooltip displays the full path of the
shortcut target (if defined).

Custom Image The image to display for the item on the task pane. Click the Browse button [...]
to select an image that is stored in the Reports Library. If the image is not
already saved in the Reports Library, you can right-click a folder and select
Import to import the image (if you have the appropriate rights to do so).

The image must be at least 32x32 pixels, and the file format must be JPG or PNG.
Larger images will be resized to fit. The image should be square because the
aspect ratio will be retained when resizing.

If no custom image is defined, then the default Axiom image for the shortcut
target is used. If the item has no shortcut target, the Axiom "dots" icon is used.
In either case (custom image or default image), an image will only display next to
an item if the parent item has Display child images enabled.

NOTES:

o Users must have permission to the image file in order to see it rendered in
the form. It is recommended to create a dedicated Images folder in the
Reports Library and store all images in this location. You can grant access to
this folder using the Everyone role, or you can create subfolders and grant
access to users and roles as needed.

« The next time you open this file after saving, the path to the image will be
automatically converted into a system-managed document shortcut (you
can tell the difference by the presence ofa _tid parameter on the end of
the shortcut). This is to make the file reference "repairable" in cases where
the file is renamed or moved. Note that if the path is a result of a formula
instead of directly within the cell, then the conversion will not occur and the
file reference will not be repairable.

This option is not available for top-level section items.
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Display Settings

Item Description

Display child Select this option if you want icons to display on the child items for the current

item images item. This option is selected at the parent item level because all child items must
have the same icon settings (enabled or disabled), so that the child items will
align appropriately in the task pane.

If enabled, then each child item will display using the associated icon for its
shortcut target. For example, if the target is a report file, then the relevant
report file icon will display next to the item. If an item does not have a shortcut
target, or if the target does not have a specific icon, then the default Axiom
Software "dots" icon is used.

If disabled, then no icons will display on child items.

Auto-number Select this option if you want to apply auto-numbering to child items for the
child items current item. If selected, all child items will be auto-numbered by whole
numbers (1, 2, 3...).

NOTE: Multi-level auto-numbering is not supported. If auto-numbering is
applied at two subsequent levels, the numbering will appear as follows:

Annual Rollowver ~

1 Save GL impart file to V\server\importfiles

~ 2 Run GL Detail Import
1 Select the appropriate year for import
2 If exceptions occur, discuss with Roger

Display child Select this option if you want all of this item's child items to display inline,
items inline omitting this item.

For example, this might be used in the following circumstances:

« When using certain items from the Command Library as targets, to hide the
"command line" and only show the contents of the command.

« When linking to a folder, to hide the "folder" node and instead display the
resulting files inline.

« When linking to a task pane, to hide the file name and instead show the
contents of the linked task pane directly within this task pane. The shortcut
parameters for the linked task pane must also be configured to enable
Embed list items.

NOTE: If this option is selected for an item that does not have any child items
(either literal child items in the structure or child items inherent to the shortcut
target), then the item will be hidden in the task pane.
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Item Description

Show restricted Select this option if you want this item to always display in the task pane,
item regardless of the user's security permissions and regardless of the current
context.

By default if a task pane item is linked to a file or feature that a user does not
have access to, then that item is hidden from the user. There are times when
that may not be the desired behavior. For example, if the task pane details a set
of process steps, you may want the user to be able to see the entire process
from start to finish, even if they do not have rights to one or more particular
items referenced in the process. For more information, see Task pane design
considerations.

If this option is selected, and the user does not have rights to the linked file or
feature (or the item is not applicable to the current context), then the item will
display as grayed out and the file or feature cannot be launched.

This option only applies to child items; it does not apply to top-level sections. By
default, if a user has no access to any items in a section, the entire section will
not display.

TIP: As you change appearance options, you can click Apply to view the result of the change within
the Axiom Assistant area, without needing to close the Edit Task Pane dialog. This only works if the
task pane was opened before editing.
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Shortcut settings

Item Description

Shortcut Target The target file or feature for the item. When a user double-clicks on the item in
the task pane, the file or feature will open.

Click the Browse button [...] to select the desired file or feature. You can select
any item that you can navigate to within Axiom Explorer. For more information
on what types of files and features can be linked to task pane items and their
behavior within the task pane, see Linking to Axiom files and features in a task
pane or ribbon tab.

Once a target is selected, Axiom Software places the necessary syntax to open
the target within the Shortcut Target box. It is best not to manually edit this
text, as you may inadvertently render the syntax invalid. If you want to select a
different target, use the Browse button to select the target rather than editing
the target syntax.

If you no longer want the item to link to a shortcut target, click the Delete
button % to remove the shortcut.

NOTE: If an item has child items, then that item cannot have a shortcut target.
When users work with the task pane, double-clicking an item with children
expands or collapses the item, so there is no way for the user to launch the

shortcut target.
Shortcut Most shortcut targets have one or more associated shortcut parameters that
Parameters impact the behavior of the linked file or feature when it is opened from the task

pane. The available parameters depend on the shortcut target—for example,
report files have different parameters than tables.

For more information on available shortcut parameters per shortcut target
type, see:

e Shortcuts

You can link to various files and other items in Axiom Software using
shortcuts. For more information, see Axiom Software Help: Reference >
Shortcuts (or search on code AX1169 to bring up the Shortcuts section).

e« Command Library

You can link to various Axiom Software features using commands in the
Command Library. For more information, see Axiom Software Help:
Reference > Command Library (or search on code AX2685 to bring up the
Command Library section).

Task pane editor settings

The option Limit to Web Client Navigation Items is located underneath the Axiom Explorer section of
the dialog. This option should only be used when you are creating a task pane that defines navigation
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links for the Web Client container. If enabled, it filters the dialog so that it only displays options that are
relevant to Web Client navigation links.

Assigning task panes to users

You can assign task panes to users and roles using the Startup tab in Axiom Software Security. When a
user starts Axiom Software, their assigned startup task panes will automatically open.

Alternatively, you can also grant permission to access one or more task panes in the Task Pane Library
directly, at the user or role level. This allows users to open task panes on demand.

Assigning as startup files

To configure a task pane to open on system startup for a particular user or role, use the Startup tab of
Security. Any task panes listed on the Startup tab will open automatically when the user starts the Excel
Client or the Windows Client. Task panes do not apply to the Web Client. For more information on
assigning startup task panes, see the Security Guide.

When task panes are assigned as startup files, users do not otherwise need to be granted access to these
files. The files will open automatically at startup.

When assigning the startup file, you may want to use the Shortcut Parameters to designate the task
pane as non-closeable. This ensures that the task pane will always be available to the user. This option is
provided so that users do not accidentally close the task pane and then have no way to reopen it
(because they do not otherwise have permissions to the file).

In most cases, you will configure startup task panes on a per role basis. For example, you might have a
Budget User role, and you want all users in this role to see a simple task pane tab that presents the
handful of items that they need to access. Alternatively, if all users in a system need to see a particular
task pane on startup, you can configure it for the Everyone role.

Startup task panes display in the Axiom Assistant area when opened, in the following order:
1. Task panes assigned to the Everyone role.

2. Task panes assigned to other roles that the user belongs to (multiple roles are sorted in
alphabetical order).

3. Task panes assigned to the user.

Keep in mind that the visibility of a startup task pane may depend on whether the task pane has any
content to display. For example, the built-in Process task pane is assigned to the Everyone role by default
and therefore it opens at startup for all users, but if a user does not have any process tasks then the task
pane does not display for that user.

Access to the Task Panes Library

If desired, you can grant users read-only access to files in the Task Panes Library, using the Files tab of
Security. This allows users to access the library from the Explorer task pane, and then open task panes on
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demand. You can also link to task panes from within a task pane or a ribbon tab, and in this case the user
must have read-only access to the task pane in order to open it using the link.

You might do this if you have some task panes that users only need to access occasionally, when
performing certain tasks. In this case it may not make sense to open these task panes at startup. When
users want to open one of these task panes, they can double-click on it in the Task Pane Library, and it
will open as a task pane in the Axiom Assistant area. They can then close the task pane when they are
finished with it, by clicking on the X button on the task pane tab.

In most cases, end users do not need to edit task panes and therefore do not need read/write access to
these files. However, if you have non-administrator users who need to create and edit task panes, those
users must be granted the Administer Task Panes permission as well as read/write access at a file or
folder level in the Task Panes Library.

Associating a task pane with a particular file
You can associate a task pane with a particular file, so that the task pane automatically opens when that

file is opened, and remains available for use while the file remains open.

For example, you might want to allow users to change refresh options for a report within a task pane
instead of using a refresh dialog. Or you might design a task pane to assist users in completing their plan
files, and you want that task pane to be automatically available when users are working in a plan file.

The associated task pane can be a custom task pane in the Task Panes Library, or it can be an Axiom form
that has been designed for use as a task pane. For more information about designing an Axiom form for
use as a task pane, see the Axiom Forms and Dashboards Guide.

Specifying the associated task pane for a file

To associate a task pane with a file, use the Associated Task Pane setting within the file. This setting is
located on the Control Sheet, in the Workbook Options section:

17 Workbook Options

18 Workbook Protection On/Off Off
19 Workbook Protection OnfOff during snapshot | Off
20 Downgrade to read-only on open Off

21 Process alerts on save data
22 Process alerts on save document
23 | Associated Task Pane document:/NAxiom\Repouts Library\Formsirefresh task pane.xlsx?Axiom TabName=Refresh

Specify the full path and file name to one of the following:
o Acustom task pane file in the Task Panes Library (AXL file)
o Aform-enabled file, where the form has been designed for use as a task pane

For example:
\Axiom\Task Panes Library\MyTaskPane.axl

\Axiom\Reports Library\Forms\MyTaskPane.xlsx
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To easily obtain the full path for a file, navigate to that file in the Explorer task pane, then right-click and
select Copy document path to clipboard. You can then paste the value into the cell.

Alternatively, you can use document shortcut syntax to specify the task pane file. When using a
document shortcut, you can add a parameter to specify an alternate tab name for the task pane. If
specified, this tab name will be used instead of the file name. For example:

document://\Axiom\Task Panes Library\MyTaskPane.axl?AxiomTabName=MyTab

To create the document shortcut syntax, take the normal file path and then add the text document://
to the front of it. To use the optional tab name parameter, append the text ?AxiomTabName=Name to
the end of the shortcut.

The next time you open the document after saving, the entry will be automatically converted into a
system-managed document shortcut (you can tell the difference by the presence ofa tid parameter
on the end of the shortcut). If you need to change the entry to point to a different document, or to
change the tab name, simply enter the path or document shortcut as you would have originally, and it
will be converted again when you save the file.

NOTE: The user must have at least read-only permission to the associated task pane file in order to
open it. If the user does not have access to the file then the task pane will not open and no error will
display. If desired, when configuring security access to the task pane you can clear the Show in
Explorer option so that the task pane does not display in the Explorer task pane or other "Explorer
views."

If the Axiom file is form-enabled, then the associated task pane does not apply when the file is open as an
Axiom form, with one exception: if the associated task pane is being used to define navigation links for
the form, those links will display in the Navigation panel of the Web Client container. For more
information on using an associated task pane to define navigation links for an Axiom form, see the Axiom
Forms and Dashboards Guide.

Task pane behavior
When a task pane is associated with an Axiom spreadsheet file, the following behavior occurs:

o Thetask paneis opened automatically when a user opens the file, and the task pane is made
active—meaning the task pane is selected and visible in the Axiom Assistant area. The tab name of
the task pane is the file name, unless an alternate tab name has been specified using document
reference syntax (see the previous section).

o Thetask paneis non-closeable. As long as the file is open, the task pane will remain open. The task
pane will automatically close when the file is closed.

o Thetask paneis linked to the file. If the user moves to a different file, the task pane will hide, and if
the user moves back to the file the task pane will become visible again.
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The same task pane can be associated with multiple files. If a user has multiple files open with the same
associated task pane, the behavior depends on whether the task paneis a custom task pane or an Axiom
form.

« Axiom form: Each file has its own separate instance of the task pane (though only a single
instance displays at any one time, depending on which file is the currently active file). Each
instance maintains its own state for the active document.

o Custom task pane: One instance of the task pane is opened. This single instance remains linked to
all associated files, but does not maintain a separate state for each file.

Ribbon tabs

You can use ribbon tabs to provide users with a custom user interface on the ribbon in the Excel Client or
the Windows Client. For an overview of how the Axiom user interface can be customized, see About
custom task panes and ribbon tabs.

The ribbon is the name of the multi-tabbed toolbar area across the top of the Axiom Software
application. In the Excel Client this area includes the full Excel ribbon. You might also think of this area as
the Axiom Software menu.

Vo] Budget 207 - y 2 b—' Hswe - 2 Retresn - CrCuick Fiter | WSPrint + [ File Processing - | {2} Show Home [} Protect - 0 e
5] Capital Requests » 5] Change View = il Drill = [FlFarms = ] Snapshat ¥ Formula Bar 1Y Toois =
Reports Tables Imports Manage - Heip Close Axiern

GaTa~ Freeze Panes E adiny
=» GaTa # | Freeze Panes E-ma Headings Software =

Example ribbon area in the Windows client

This section explains how to create, edit, and delete custom ribbon tabs, and then assign them to end
users. Ribbon tabs are managed using the Ribbon Tabs Library within Axiom Explorer. Ribbon tab files
display using the ribbon icon H.

In addition to creating your own custom ribbon tabs, you can customize the built-in ribbon tabs
provided by Axiom Software—the main Axiom ribbon tab and the Axiom Designer ribbon tab. For more
information, see Built-in task panes and ribbon tabs.

Ribbon editor

You can create and edit custom ribbon tabs using the Edit Ribbon Tab dialog. This dialog has four
sections as shown in the following example screenshot.
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Ribbon editor

The middle section, labeled Ribbon Structure, is where you define the groups and individual items to
display on the ribbon. To add new items to this structure, you can either:

e Usethe Add New Item button in the toolbar to add new items. You can choose to add a new child
item to the currently selected item, or add a new item at the same level, or add a new group-level
item.

o Use the right-click menu to add new items. This has the same options as the Add New ltem
button.

o Dragand drop an item from the Axiom Explorer pane (the left-hand section of the dialog) to the
desired location in the ribbon structure. This will automatically link the item in the ribbon
structure to the appropriate feature or file (based on what you dragged and dropped).

When you select an item in the ribbon structure, the properties for that item display in the right-hand
section of the dialog, labeled Selected Item Details. Here you can define display text and other display
properties for each item, and assign the associated feature or file for the item using the Shortcut Target.
(When you drag and drop and item from the Axiom Explorer pane to the ribbon structure, the shortcut
target is automatically assigned.) For more information on the available properties, see Ribbon tab
properties.
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You can move items in the ribbon structure by dragging and dropping them to various locations, or by
using Copy or Cut and then Paste. To remove an item, select it and then click Delete. Any child items of
the item you deleted will also be deleted.

The Preview section at the bottom of the dialog displays a preview of how the current ribbon structure
will look when it is assigned as a startup file and opened in the ribbon. The preview assumes that all items
in the ribbon are available to the user. When the ribbon is actually assigned to a user and opened at
startup, the display of each item will be dependent on the current file context and on the user's security
permissions. The currently selected item in the ribbon structure is also highlighted in the ribbon, so that
you can easily find particular items in the preview.

Managing ribbon tabs

Ribbon tabs can be created, edited, or deleted using Manage > Ribbon Tabs, in the Administration
group of the Axiom tab. You can also manage ribbon tabs from the Ribbon Tabs Library in the Explorer
task pane.

Creating a ribbon tab

You can create ribbon tabs for various purposes and display them to users in the application ribbon.
Once aribbon tab is created, it can be assigned to users and roles to open automatically when the user
logs into the system.

Ribbon tabs are created by defining one or more groups, and placing one or more child items in each
group. The top-level group item is text only and cannot link to any file or feature. Child items in the group
can link to any eligible file or feature. The following screenshot illustrates how groups and child items
display in the ribbon tab:

I'd
AXIOM EXAMPLE Horme f o ™y
| Child items
=» GoTo Location |r" Refresh Workbook in group
I@Cha"lge View » \"f/’(luick Filter T
_ Group name

As you create the ribbon tab in the editor, a preview of the tab displays in the bottom of the dialog. You
can use this preview to see what your ribbon tab will look like when displayed in the ribbon.

[ Axiom >ottware - [rair

NOTE: Only administrators and users with the Administer Task Panes security permission can create
new ribbon tabs.
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To create a new ribbon tab:
1. Onthe Axiom tab, in the Administration group, click Manage > Ribbon Tabs.

The Axiom Explorer dialog opens, with the focus on the Ribbon Tabs Library. You can also use the
Explorer task pane for this purpose.

2. Inthe Libraries section, right click the Ribbon Tabs Library, and then select New > Ribbon Tab.
The Edit Ribbon Tab dialog opens.

3. New ribbon tab files start with a single group, named Group1. Edit the name of this section using
the Group name box in the right-hand side of the dialog.

All top-level items in the ribbon tab are groups. In most cases, the only valid property for a group
is the group name.

4. Add child items to the group as needed. You can add child items by doing any of the following:

o With the group name selected, click Add New Item > Child of selected item.

o With a child item selected, click Add New Item and then either Before selected item or
After selected item.

o Dragand drop an item from the Axiom Explorer pane in the left hand side of the screen to
the desired place in the ribbon structure. A black line shows you where the item will be
placed.

You can configure each item as desired. In most cases, you want each item in the ribbon tab to
link to an Axiom file or feature. If you dragged and dropped an item from the Axiom Explorer pane
into the ribbon tab, then the item is automatically linked to that file or feature. Otherwise, use the
Shortcut Target setting to assign the item to a file or feature.

For more information on the types of files and features that can be included in ribbon tabs and
how they work, see Linking to Axiom files and features in a task pane or ribbon tab. For more
details on available appearance properties, see Ribbon tab properties.

There are a variety of ways to configure ribbon tabs. For more details on some common design
goals and avoiding potential issues, see Ribbon tab design considerations.

5. Add additional groups and child items as needed. You can add new groups by using Add New
Item > New top level group. Arrange these items as desired by dragging or dropping items within
the structure, or by using the Edit button to cut, copy, and paste.

6. Check the ribbon Preview at the bottom of the dialog, to make sure the groups and items display
in the ribbon as you expect.

7. Click OK to save.

The Save As dialog opens to the Ribbon Tabs Library. Give the file a name and optionally a
description, and save it to the desired location.

NOTE: The name of the file determines the default name of the tab in the ribbon. Make sure
the file name is brief and intuitive. When assigning the ribbon tab to users in security, you can
override the file name and define an alternate tab name using the Axiom Tab Name shortcut
parameter.
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After you have created a ribbon tab, the only way to test it in the ribbon is to assign it to yourselfas a
startup file in security, and then close and reopen Axiom Software. If the ribbon tab is for a particular
user or user group, then an administrator should also test the ribbon tab by assigning it to the
appropriate user or group and then logging in as a representative user. See Assigning ribbon tabs to
users.

Editing a ribbon tab

You can edit a ribbon tab at any time, regardless of whether it is currently open in the ribbon. Ribbon
tabs currently open in the ribbon do not impact editing availability. If a message tells you that a ribbon
tab file is locked, this means that another user has opened the ribbon tab in the editor, not that the
ribbon tab is open in the ribbon.

Ribbon tabs are only loaded at startup. If you edit a ribbon tab, you will not see the changes to that
ribbon tab until you close and reopen the system (assuming the ribbon tab is configured to open at
startup).

To edit a ribbon tab:
1. From the Axiom tab, in the Administration group, click Manage > Ribbon Tabs.

You can also access the Ribbon Tabs Library from the Explorer task pane.

2. Inthe Ribbon Tabs Library, navigate to the ribbon tab that you want to edit, then double-click it
to open.

3. Inthe Edit Ribbon Tab dialog, edit the ribbon tab as desired.

4. Click Apply or OK to save the ribbon tab. If you would rather save this ribbon tab as a new file, you
can click File > Save As from the dialog toolbar.

Deleting a ribbon tab

You can delete a ribbon tab at any time. It does not matter if the ribbon tab is currently open on the
ribbon in your session or any other user's session.

If aribbon tab is currently open in a user's session and that ribbon tab file is deleted, the ribbon tab will
remain useable in that session until the user exits the system. If the deleted ribbon tab was configured to
open on startup, no special steps are required to remove it from user configurations—the next time
users log in, the ribbon tab will simply no longer exist and therefore will be ignored by the startup
configuration. However, it is a good idea to remove the obsolete configuration from Security so that user
configurations match what you expect to be displayed.

To delete a ribbon tab:

1. From the Axiom tab, in the Administration group, click Manage > Ribbon Tabs. You can also
delete ribbon tabs using the Explorer task pane.

2. Inthe Ribbon Tabs Library, navigate to the ribbon tab that you want to delete, then right-click
and select Delete.
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Ribbon tab design considerations

Keep in mind the following design considerations when creating ribbon tabs.

Creating ribbon tabs with multiple groups

All top-level items in a ribbon tab define groups within the ribbon. Each group can have one or more child
items that display as buttons in the group.
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Sample ribbon tab definition with two groups
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Display of tab in the ribbon

Most ribbon tabs will have multiple groups. Groups are used to organize the ribbon into logical sections
and help users find the buttons they are looking for. If all buttons in the ribbon tab are within a single
group, this may make the ribbon tab difficult to use.

In most cases, the only valid property for a top-level item is the display text to define the group name.
Top-level items in a ribbon tab cannot be assigned to a shortcut target and do not use any of the display
options. However, there are two exceptions:

o The Excel Command Button command can be placed at the top level, to display an entire Excel
group in the ribbon tab.

o An Axiom Managed Group command can be placed at the top level, to include the entire contents
of an Axiom group in the ribbon tab.

Both of these exceptions are discussed later in this design considerations topic.

Using Axiom Managed Groups in a ribbon tab

Axiom Managed Groups are special commands that allow you to include the entire contents of a
particular ribbon group in a custom ribbon tab. The contents of each group are based on the default
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Axiom ribbon tab that is delivered with the application.

The advantage of using an Axiom Managed Group is that the group will remain in sync with the default
Axiom ribbon tab as you upgrade the software. So if a new feature is added to the File Qutput group in a
particular release, and you are using the Axiom Managed Group command for File Output in a custom
ribbon tab, then the new feature will automatically be included in the custom ribbon tab. If instead you
have customized the File Output group and are no longer using the Axiom Managed Group command,
then you would need to manually add the new feature to the custom ribbon tab if you wanted it to
display.

The built-in Axiom ribbon tab (AxiomMain.AXL)is made using Axiom Managed Groups. If you want to
create a new custom ribbon tab that uses these groups, it is easiest to copy this file and then edit the
copy as desired. However, if you want to manually add an Axiom Managed Group to a custom ribbon
tab, you can do so as follows:

o Inthe Axiom Explorer pane of the Edit Ribbon Tab dialog, navigate to the Groups/Sections folder
of the Command Library.

o Dragand drop the desired group from the Command Library to the Ribbon Structure pane, as a
top-level group item.

Itis not possible to add a new "blank" group item and then link it to the group command, because by
default the Shortcut Target field is not available for group items. You must either drag and drop the
command as a top-level item directly, or create a new child item and link it to the command, then move
the child item up to the top level.

If a ribbon tab already contains an Axiom Managed Group, and you want to customize the contents of
that group to remove or add features (or otherwise modify the configuration of individual items in the
group), then you can "convert" the group to its individual commands. To do so, right-click the group and
then select Convert group to individual items. The group will be replaced with all of the individual items
in that group, so that you can modify the group as desired. However, keep in mind that converted
groups are no longer system-managed and will not automatically update for future changes.

Creating drop-down menus and "split buttons" in a ribbon tab

Non-group items in a ribbon tab can also have child items. If the user clicks on the "parent" item in the
ribbon tab, a drop-down menu allows the user to click one of the child items. This will either perform the
configured action for the child item, or open a further sub-menu if the item has child items.

Some features that you can link to in a ribbon tab are automatically drop-down menus. For example, if
you use the Axiom Function command and select a function group in the shortcut parameters, then
clicking this button will automatically display a drop-down menu of the functions in that group. In this
case you should not place any child items under this item, as this will cause the default menu to not
display as expected.

It is also possible to configure "split buttons" in ribbon tabs. A split button is a button that performs a
default command, but also has a secondary drop-down menu where users can select related commands.
For example, the Refresh button on the default Axiom tab is a split button. To create a split button, you
assign a shortcut target to the "parent" item, and then also assign child items to that item. This
configuration will automatically render as a split button in the ribbon tab.
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Ribbon Tab Structure
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Example ribbon tab structure

When this ribbon definition is rendered as a ribbon tab, the Examples group will have two buttons:

o Save button: Because the Save parent item is linked to a command, users can click on the Save
button to perform a save, or they can use the secondary drop-down menu to save the file only or
data only. This would be similar to the Save button on the default Axiom tab.

o Manage Tables button: Because the Manage Tables parent item is not linked to a command,
clicking that button does not perform an action. Instead it brings up a drop-down menu where
users can open the Table Library or add a table.

If the split button or drop-down menu has several items in it, you may want to use separator text to
organize the menu. You can do this by adding an item where you want the separator text to display, and
then only defining display text for that item. This non-linked item will automatically display as separator
text in the drop-down menu. For example:

ESE‘JE‘ -
€) Manage Tables - ..ThiS item is r"ICI'[...\
Bt | Table Library | ‘ linked to
Table Tools Y anything, it is
+ | Add Table | only display text

[ | Copy Table Data

Hiding items in the ribbon tab

By default, the option to Show restricted item is selected for all child items in a ribbon tab. This means
that the item will always display in the ribbon tab, but it will be grayed out and unavailable if the user
does not have permission to use the feature, or if the feature does not apply to the current context.

In most cases, it is recommended to leave this option selected. It may be disorienting to users to have
options in the ribbon tab appear and disappear if it is not obvious why this behavior is occurring. Users
may wonder why a particular command no longer displays on the ribbon tab, without realizing that the
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command does not apply to the current context. However, in certain cases it is best to disable this
option—such as when placing file groups and file group categories on the ribbon, so that users do not
see file groups that they do not have access to.

Leaving this option selected for most items in a ribbon tab also avoids the potential issue of displaying
entirely blank ribbon tabs. Depending on the commands in your ribbon tab, it is possible to end up in
situations where none of the commands apply to the current context, and therefore the entire ribbon
tab is blank. For example, if your home page is an Axiom form instead of a spreadsheet file, then none of
the commands that can be normally used in a spreadsheet file apply to this context, and they will not
display on the ribbon tab unless Show restricted items is selected.

NOTE: This option is not available for Axiom Managed Groups; the visibility of commands in the
group is system-managed.

Including Excel features on an Axiom ribbon tab

You can include Excel features on an Axiom ribbon tab, using the Excel Command Button in the
Command Library. You can enter Excel command IDs to incorporate virtually any Excel feature on the
ribbon. This feature is only supported for use in the Excel Client; the Windows Client will ignore any item
set to the Excel Command Button.

It is also possible to include entire Excel command groups on the ribbon. To do this:
o From the Axiom Explorer pane in the Edit Ribbon Tab dialog, locate the Excel Command Button
command in the Command Library, and then drag and drop it into the ribbon tab structure as a
top-level item.

o Usethe shortcut parameters to specify the appropriate Excel Control ID for the group that you
want to display. The Excel Control Type must be set to Group.

Group codes cannot be looked up in the Excel Options dialog like button codes. You will need to
download the appropriate resources from Microsoft to look up the desired group codes, as
discussed in the Excel Command Button topic referenced above.

e The group node cannot have any child items. Excel will automatically populate the group node
with the features that normally display in the specified group.

Displaying child items inline
If an item has child items, you can choose to display those items inline (at the level of the parent item),

omitting the display of the parent item. To do this, you must enable Display child items inline for the
parent item.

For example, you may want to create a drop-down menu with a couple of feature commands at the top,
followed by the contents of a particular folder (similar to the Reports menu). To do this, you can add the
folder to the ribbon tab structure, and then enable Display child items inline for that item. When the
ribbon is rendered to users, the folder item will be omitted and instead the individual files in the folder
will dynamically display in the drop-down menu.
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The inline behavior applies whether the child items are defined in the ribbon tab structure, or if the child
items will be generated dynamically based on the parent item. In the previous example, the individual
files aren't defined in the ribbon tab structure, they are generated dynamically based on the folder
parent item. However, keep in mind that if the child items are displayed directly on the ribbon instead of
in a drop-down list, then they will not update dynamically as changes are made to the folder in that
session.

Ribbon tab properties

The following properties are available for items in a ribbon tab. If you are editing one of the built-in
ribbon tabs (Axiom and Axiom Designer), see the following for more information on those tabs: Built-in
task panes and ribbon tabs.

The available settings for each item in a ribbon tab depends on whether it is a top-level group item, or a
child item in a group.

Top-level group items

Each top-level item in the ribbon structure is a group item. Group items are identified in the ribbon
structure with a gray bar.

Generally speaking, group items define the label for each "group" or section of items in the ribbon tab.
Most group items only have a single property of Group Name. However in a few cases groups can have
assigned Shortcut Targets and can be used to include entire groups of content in the ribbon.

Item Description

Group Name The label to display for the group in the ribbon tab.

If the group has an assigned Shortcut Target, then you can leave this box blank
and the group name will be determined by the shortcut target.

Otherwise, if no group name is defined then the group will have no label in the
ribbon tab. The only indicator of a separate group will be the divider lines
between groups.

Use large image This option only applies if the group item is an Axiom Managed Group. If this
option is selected, then all items that belong to the managed group will display
using the large versions of their associated icons, instead of the small versions.
By default, all items display using the small versions of their associated icons.

NOTE: Using large icons can quickly fillup the ribbon tab. It is recommended to
use small icons for managed groups unless you know there will be adequate
space on the ribbon tab for the large icons.
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Item Description

Shortcut Target The target command in the Command Library to use for the group item. This is
only permitted in two circumstances:

o You can drag and drop the Excel Command Button command as a top-level
item and configure it to display a predefined Excel group. This is only
supported for use in the Axiom Excel Client; the Axiom Windows Client will
ignore the group and hide it in the ribbon tab.

e You can drag and drop an Axiom Managed Group command as a top-level
item, to automatically display all items of that group in the ribbon tab.

NOTE: It is not possible to add a "blank" group item to the ribbon structure and
then link it to the desired shortcut target, because the Shortcut Target field
does not display by default for group items. Instead, you must drag and drop
an eligible command from the Axiom Explorer pane to the Ribbon Structure
pane. (Or, you can add a child item to the ribbon structure, link it to the desired
command, and then move that child item up to the group level. This is only
permitted if the command is eligible to be used at the group level.)

Shortcut This section only applies if the group item uses the Excel Command Button. You
Parameters can use the shortcut parameters to specify which Excel group should display on
the ribbon tab.

Child items

Each child item within a group defines a feature or file to display in the ribbon tab.

Item Description

Display Text The text to display for the item in the ribbon tab. If the item has a defined
shortcut target to an Axiom file or feature, then you can leave this box blank,
and the display text will be the name of the file or feature.

Tool Tip The text to display as a tool tip when a user hovers their cursor over the item.
This text can be helpful to explain the purpose of the item within the context of
the ribbon tab. If no tool tip text is defined, then the tooltip displays the full
path of the shortcut target (if defined).
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Item Description

Custom Image The image to display for the item on the ribbon tab. Click the Browse button
[...] to select an image that is stored in the Reports Library. If the image is not
already saved in the Reports Library, you can right-click a folder and select
Import to import the image (if you have the appropriate rights to do so).

The image must be at least 32x32 pixels, and the file format must be JPG or PNG.
Larger images will be resized to fit. The image should be square because the
aspect ratio will be retained when resizing.

NOTES:

o Users must have permission to the image file in order to see it rendered in
the form. It is recommended to create a dedicated Images folder in the
Reports Library and store all images in this location. You can grant access to
this folder using the Everyone role, or you can create subfolders and grant
access to users and roles as needed.

o The next time you open this file after saving, the path to the image will be
automatically converted into a system-managed document shortcut (you
can tell the difference by the presence ofa tid parameter on the end of
the shortcut). This is to make the file reference "repairable" in cases where
the file is renamed or moved. Note that if the path is a result of a formula
instead of directly within the cell, then the conversion will not occur and the
file reference will not be repairable.

If no custom image is defined, then the default Axiom image for the shortcut
target will be used.

This option does not apply if the shortcut target for the item is a command that
displays with a check box (such as Freeze Panes).

Display settings

Item Description

Display child Select this option if you want all of this item's child items to display inline,
items inline omitting this item. For example, this might be used when linking to a folder, to
hide the "folder" node and instead display the resulting files inline.

NOTE: If this option is selected for an item that does not have any child items,
then the item will be hidden in the ribbon tab.
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Item Description

Show restricted Select this option if you want this item to always display in the ribbon tab,

item regardless of the user's security permissions and regardless of the current
context. This option is selected by default. If the item cannot be used by the
user, then it will display as grayed out.

If this option is disabled, then the item will not display on the ribbon tab if it
cannot be used. It is common to disable this option when placing file groups on
aribbon tab, so that users only see the file groups that they have security
permission to access.

Use large image Select this option if you want the item to display using the large version of its
associated icon, instead of the small version. By default, all items display using
the small version of the associated icon.

This option does not apply if the shortcut target for the item is a command that
displays with a check box (such as Freeze Panes), or if the item is rendered in a
drop-down list on the ribbon. Only items that display directly on the ribbon as
buttons are eligible to use large icons.

Shortcut settings

Item Description

Shortcut Target The target file or feature for the item. Click the Browse button [...] to select the
desired file or feature. You can select any item that you can navigate to within
Axiom Explorer, including using commands in the Command Library. For more
information, see Linking to Axiom files and features in a task pane or ribbon tab.

Alternatively, you can drag and drop items from the Axiom Explorer pane in the
editor directly to the ribbon tab structure, to both create a new item and link it
to that file or feature.

Once a shortcut target is defined, Axiom Software places the necessary syntax
to open the target within the Shortcut Target box. It is best not to manually edit
this text, as you may inadvertently render the syntax invalid. If you want to
select a different target, use the Browse button to select the target rather than
editing the target syntax. If you no longer want the item to link to a shortcut
target, click the Delete button > to remove the shortcut.

NOTE: All child items in the ribbon tab structure should be assigned a shortcut
target, with one exception. If you are configuring an item as a split button or a
drop-down menu, and you want to place a separator in the drop-down menu,
then you would leave the shortcut target for the item blank and just define
display text. Otherwise, child items without an assigned shortcut target will not
display in the ribbon.
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Item Description

Shortcut Most shortcut targets have one or more associated shortcut parameters that

Parameters impact the behavior of the linked file or feature when it is opened from the
ribbon tab. The available parameters depend on the shortcut target—for
example, report files have different parameters than tables.

For more information, see the following:
« Shortcuts

You can link to various files and other items in Axiom Software using
shortcuts. For more information, see Axiom Software Help: Reference >
Shortcuts (or search on code AX1169 to bring up the Shortcuts section).

e« Command Library

You can link to various Axiom Software features using commands in the
Command Library. For more information, see Axiom Software Help:
Reference > Command Library (or search on code AX2685 to bring up the
Command Library section).

Assigning ribbon tabs to users

You can assign ribbon tabs to users and roles using the Startup tab in Axiom Software Security. When a
user starts Axiom Software, their assigned startup ribbon tabs will automatically open.

Ribbon tabs can only be opened at startup. It is not possible to allow users to open ribbon tabs "on
demand". Generally speaking, the only reason to grant a user file access to ribbon tabs in the Ribbon
Tabs Library is if the user needs to create and edit ribbon tabs.

Assigning as startup files

To configure a ribbon tab to open on system startup for a particular user or role, use the Startup tab of
Security. Any ribbon tabs listed on the Startup tab will open automatically when the user starts the Excel
Client or the Windows Client. Ribbon tabs do not apply to the Web Client. For more information on
assigning startup ribbon tabs, see the Security Guide.

When ribbon tabs are assigned as startup files, users do not otherwise need to be granted access to
these files. The files will open automatically at startup. Keep in mind that the visibility of the ribbon tab
depends on its configuration. Using the shortcut properties for the startup file, you can configure the
ribbon tab so that it only displays if certain conditions are met, such as:

o Whether the useris an administrator
o Whether the user has access to the Sheet Assistant
o Whether a particular type of file is open

For example, a ribbon tab can be associated with report file types. Therefore, although the ribbon tab is
technically opened at startup, it does not actually display to the user until a report file is opened.
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In most cases, you will assign startup ribbon tabs on a per role basis. For example, you might have a
Budget User role, and you want all users in this role to see a simple ribbon tab that presents the handful
of items that they need to access. Alternatively, if all users in a system need to see a particular ribbon tab
on startup, you can configure it for the Everyone role.

Startup ribbon tabs will be opened in the following order:

1. Ribbon tabs assigned to the Everyone role.

2. Ribbon tabs assigned to other roles that the user belongs to (multiple roles are sorted in
alphabetical order).

3. Ribbon tabs assigned to the user.

All custom ribbon tabs display before (to the left of) any Excel ribbon tabs. In the case of the Windows
Client, custom ribbon tabs display before the Home tab. Once a ribbon tab is opened, it cannot be closed
by the user (though it may become hidden depending on its configuration and the current context).

Access to the Ribbon Tabs Library

Itis not possible to open aribbon tab "on demand" from the Ribbon Tabs Library. If a user double-clicks
on aribbon tab file, it willopen in the ribbon tab editor, not in the ribbon. The only way to access a
ribbon tab is to assign it as a startup file and then restart the application. Therefore, there is no reason to
give a user file permission to ribbon tab files in the Ribbon Tabs Library unless the user needs to create
and edit ribbon tabs.

If you have non-administrator users who need to create and edit ribbon tabs, those users must be
granted the Administer Task Panes permission as well as read/write access at a file or folder level in the
Ribbon Tabs Library.

Linking to Axiom files and features in a task pane
or ribbon tab

Items in a custom task pane or a ribbon tab can be linked to an Axiom file or feature. To link an item to a
file or feature, you use the Shortcut Target property for the item. Depending on the shortcut target,
there may also be Shortcut Parameters to further configure the behavior of the shortcut.

To define a shortcut for an item in a task pane or a ribbon tab:
1. Inthe Edit Task Pane dialog or the Edit Ribbon Tab dialog, select the item that you want to link to
a file or feature.

2. Click the Browse button [...] to the right of the Shortcut Target box. Then, in the Axiom Explorer
dialog, navigate to the item that you want to link to.

You can link to any folder, file, or other item that is displayed in Axiom Explorer. Additionally, the
Command Library is available when defining task panes and ribbon tabs, so that you can link to
Axiom features. For more information, see the following reference material:
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e Shortcuts

You can link to various files and other items in Axiom Software using shortcuts. For more
information, see Axiom Software Help: Reference > Shortcuts (or search on code AX1169 to
bring up the Shortcuts section).

e« Command Library

You can link to various Axiom Software features using commands in the Command Library.
For more information, see Axiom Software Help: Reference > Command Library (or search
on code AX2685 to bring up the Command Library section).

NOTE: You can also link items to files and features by using the Axiom Explorer pane within the
editor. If you drag and drop an item from the Axiom Explorer pane to the task pane or ribbon
tab definition, then a new item will automatically be created and that item will be linked to the
appropriate shortcut target.

3. Configure the available Shortcut Parameters for the item, if applicable.

Some items have additional options that impact how the item behaves in the task pane or the
ribbon tab. The available options are specific to the item type.

4. Define the Display Text for the item as desired.

By default, the item will display using the name of the shortcut target—for example, the file name
if the target is a file. If you want to specify a different name, then enter different text into the
Display Text box.

If you assign a shortcut target to an item and then later you want to remove the shortcut, click the
Delete button 7 to the right of the box. You can also click the Browse button again to select a different
shortcut target.

Visibility of linked items
The visibility of a linked item in a task pane or a ribbon tab depends on the following:

o Whether the user has rights to access the linked file or feature. In most cases, if a user does not
have permission to an item, the item does not display in the task pane or ribbon tab. For example,
if the item links to a report that the user does not have access to, the item does not display
because the user cannot open the report.

o Whether the linked feature applies to the currently active file. In most cases, if the item is a file-
related feature but it does not apply to the currently active file type, then the item does not
display in the ribbon tab. For example, if the item links to the Add Rows command, but the
currently active file is a report, then the item does not display because calc method libraries
cannot be used in report files.

o Whether the linked item is valid. If the shortcut target of an item is invalid, then the item does not
display in the task pane or ribbon tab because it cannot be used. A user with the appropriate
permissions must go to the editor to see and fix the invalid item. For example, if the item links to a
report but the report is later deleted, the item does not display because it is invalid.
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o Whether Show restricted item is enabled for the item. If enabled, then the item will always
display, regardless of any of the previously-listed factors. If the item cannot be used for any
reason, then it displays as grayed out. You might enable this option if you want the items in the
task pane or ribbon tab to remain constant for all users and all contexts.

NOTE: The visibility rules above are general guidelines. Certain commands have different behavior.
See the help topic for the specific command for more information on the visibility rules for that
command.

The default state of Show restricted item depends on whether you are creating a task pane or a ribbon
tab. In task panes, the option is disabled by default, meaning that items will be hidden if the user cannot
use them. In ribbon tabs, the option is enabled by default, meaning that items will display as grayed out
if the user cannot use them. For more information, see Task pane design considerations and Ribbon tab
design considerations.

Converting task panes and ribbon tabs

You can convert an existing task pane file into a ribbon tab, and vice versa. The general structure of the
task pane or ribbon tab definition is applicable to both formats.

When you convert a task pane or a ribbon tab to the other format, a copy of the original file is created
and that new file is converted. The original file remains intact. For example, if you convert a task pane
named "Reports," a new ribbon tab file is created within the Ribbon Tabs Library named "Reports". You
can then rename the new file as needed.

Task panes and ribbon tabs can use settings that don't apply to the other format, and can link to files
and features that aren't supported in the other format. Generally speaking, if this occurs the inapplicable
setting or unsupported feature will simply be ignored in the new format after conversion. However, you
should test the file in its new format to make sure that everything displays and works as intended.

To convert a task pane or a ribbon tab:
1. In Axiom Explorer or the Explorer task pane, locate the task pane file or ribbon tab file that you
want to convert.

2. Right-click the file, and then select either Convert to ribbon or Convert to task pane.

A copy is created of the original file, and that copy is converted to the specified format. The copy is placed
in the corresponding library. For example if you convert a ribbon tab to a task pane, the copy is created
in the Task Panes Library.

Considerations when converting a task pane to a ribbon

The following task pane settings are inapplicable to ribbon tabs and will be ignored in that format:
o Display child item images
o Auto-number child items
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Some task pane shortcuts, such as the built-in feature controls for Axiom Explorer and Process
Management, are not supported in the ribbon format. These items will be ignored when the ribbon is
displayed.

Some designs that are well-suited for the task pane format are not well suited for the ribbon format,
although they will be technically converted. For example, if the task pane depicts a numbered process, it
will be converted to the ribbon but the numbers will be lost, and the process flow will not be as clear as it
would be in a task pane.

Considerations when converting a ribbon to a task pane
The following ribbon settings are inapplicable to task panes:

o Use large image (option will be ignored in the task pane)
o Shortcut targets defined on items with children (users will be unable to launch the shortcut target)

Task panes do not support the concept of a "split button"” where you can click on the parent button to
perform a particular action, or you can open a sub-menu to perform other actions. In the task pane
format, if an item has child items then double-clicking the parent item will only expand or collapse the
child items; no action will be performed. If a shortcut target is assigned to a parent item in a task pane,
this target will be ignored when the task pane is in use. Within the task pane editor, this configuration will
result in a validation error.

Built-in task panes and ribbon tabs

In addition to the custom task panes and ribbon tabs that you can create for your system, Axiom
Software provides certain built-in task panes and ribbon tabs.

Some of these built-in items are entirely system-controlled, such as the Axiom ribbon tab, the Sheet
Assistant task pane, or the File Processing task pane. These items cannot be customized.

Other built-in items are provided by default, but can be customized if desired. You can edit these items,
modify their display behavior, or disable them entirely if desired. These customizable items are:

o Axiom Designer ribbon tab

o Explorer task pane

e Process task pane

o Workflow task pane (see Axiom Software Help for more information)

Customizing the Axiom ribbon tab

Axiom Software provides a built-in Axiom ribbon tab to provide access to Axiom functionality. By default,
this tab is assigned as a startup file for the Everyone role in security, and is configured to display to all
users in all circumstances. If desired you can do any of the following:

o Customize the contents of the Axiom Designer ribbon tab
o Create different versions of the tab and assign them to different users and roles
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o Disable the tab for certain users and roles

IMPORTANT: If you choose to customize the Axiom ribbon tab, it is possible that you could
inadvertently create an environment where no users can access a certain feature, because that
feature is no longer available on any menu. You should take care to ensure that administrators
always have access to the full set of Axiom features. If you are customizing a version of the Axiom
ribbon tab that is meant for administrators, and you choose to remove a feature from that tab, you
should make sure that feature is available to administrators in some other way—either in another
custom ribbon tab or task pane that is available for administrator use, or in the Axiom right-click
menu.

Default behavior

When a new system is created, or when an older system is upgraded, a copy of the Axiom ribbon tab is
placed in the root of the Ribbon Tabs Library, using the file name AxiomMain.AXL. This copy is listed as
a startup ribbon tab for the Everyone role.

NOTE: You can rename the file and/or move it into a subfolder without breaking the existing startup
configuration. For example, you may want to create a Startup subfolder in the Ribbon Tabs Library to
hold all of the ribbon tabs that are configured to open at startup.

This custom ribbon tab replaces the old system-controlled Axiom ribbon tab. Using a custom ribbon tab
for the Axiom tab allows clients to fully customize the Axiom menu as desired. If you do not want to
customize the Axiom menu, then you can leave the ribbon tab as is.

Customizing the contents of the Axiom tab

You can customize the contents of the Axiom ribbon tab by modifying the AxiomMain.AXL file, or by
copying the file and creating different versions for different user audiences. You can add features to the
tab, reorganize the tab, or remove features from the tab. For more information on creating and editing
ribbon tabs in general, see Ribbon tabs.

The built-in Axiom ribbon tab is designed using Axiom Managed Group commands. These group
commands correspond to the groups (sections) on the default Axiom ribbon, such as Administration, File
Options, and File Output. When a group command is used, all features that are part of that group are
automatically included on the ribbon.
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NOTE: A few groups in the default Axiom ribbon tab are not built using group commands. The File
Groups group is always customized per installation and therefore does not have a defined set of
commands. The Reports group and the Exit group do not have group commands because there is
only one button in each group.

The benefit of using managed group commands is that the contents of the group will remain in sync with
the default Axiom ribbon. This means that if Axiom Software adds a new feature to the File Options
group in a future release, then any custom ribbon tabs (or task panes) that use the managed File Options
group will automatically update to display that new feature. If instead you decide to customize your
ribbon tab so that the File Options group consists of individual commands instead of the managed group
command, then your ribbon tab would not automatically update for the new feature. You would have to
manually edit your ribbon tab to add it.

Keep in mind the following when customizing the contents of the Axiom ribbon tab:

o Itis recommended to use Axiom Managed Group commands whenever it makes sense to do so,
because this will make it easier to access new features in the future.

o Use caution before removing entire groups from the ribbon tab. Remember that if a user does not
have any access to any items in a particular group, then that group will not display on the ribbon.

For example, it is not necessary to remove the Administration group from a ribbon tab if you do
not want end users to see it, because by default it will not display to those users anyway. But if
you choose to remove it, then any end users who do have special security permissions to certain
administration features will now have no way to access those features. You should either leave the
Administration group on the ribbon and rely on security permissions to hide or show it as
necessary, or make sure that you identify those end users who need special access to certain
features and assign them a different version of the ribbon tab that contains those features.
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o Ifyou absolutely need to customize the contents of a group, then the easiest way to begin is to
"convert" the group to its individual items. You can convert a group by right-clicking it and
selecting Convert group to individual items. This conversion process removes the group
command from the ribbon and replaces it with a collection of individual commands that are
configured to match the way those commands display in the group. You can then remove
individual commands from the group, or change the configuration of these commands, or add

different commands to the group.

Example customization

Many clients have requested the ability to create different menus for administrators versus end users.
You can do this by creating different versions of the Axiom ribbon tab and then assigning them to

different users and roles.

Imagine that you do not want your end users to have access to the Snapshot feature on the default

Axiom ribbon tab. You can do the following:

o Create a copy of AxiomMain.AXL and name it something like AxiomEndUser .AXL.

o Modify AxiomEndUser .AXL to remove the Snapshot feature:

o Right-click the File Output group, then select Convert group to individual items.

Administration
File Options
File Output
Display
Advanced

Convert group to individual items

X Delete

%+  Add New Item 3

Axiom Managed Group (7]
Axiom Managed Group (7]
Tour @
oup @
oup @

Help
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o A warning message informs you that the group will no longer be system-managed. After
clicking OK to continue, there is now a regular top-level item with a Group Name of File
Output, followed by child items for each feature in that group.

File Options
* File QOutput
» ¥ Print
. Snapshot
E-mail
& File Processing

Display
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o Inthe converted File Output group, right-click the items for Snapshot and E-mail and then
click Delete. (The E-mail Workbook feature also allows taking a snapshot, so you would
need to remove both items if you wanted to completely remove the feature from the
ribbon.)

« Modify Axiom security so that end users are now assigned the AxiomEndUser.AXL ribbon tab as
a startup file instead of AxiomMain.AXL.

The way that you do this will depend on how your security is set up. If all of your end users belong
to certain roles, then you can assign AxiomEndUser .AXL to those roles. You can then modify the
configuration of the Everyone role so that AxiomMain.AXL only displays to administrators. Or,
you could remove AxiomMain.AXL from the Everyone role entirely, and instead assign it to an
administrator role or individual administrator users.

When you assign a ribbon tab as a startup file, remember to set the Axiom Tab Name. If you do not
define the Axiom Tab Name, then the tab will use the file name (in this case, AxiomEndUser).

Restoring the default Axiom ribbon tab

If you modify the default AxiomMain.AXL file and then later you decide that you want to restore the file
to its original configuration, a copy of the default file is always available in \Axiom\Axiom
System\Document Templates\Sample Ribbon Tabs.

Keep in mind that if you delete the copy in the Ribbon Tabs Library and then replace it with a copy from
the sample folder, you will need to reconfigure your security settings to point to the new file (because
startup shortcuts are based on document ID, not on file name and location). Alternatively you can
import the default file over the copy in the Ribbon Tabs Library. To do this in Axiom Explorer:
o Right-click the default file in the Sample Task Panes folder, and select Export to save it to your local
file system.
o Right-click the Task Panes Library and select Import Files to import the file from your local file
system. This will overwrite the existing file if they both have the same name, and retain the
document ID.

IMPORTANT: If your system is accidentally put in a state where an administrator cannot access
necessary system features using the Axiom ribbon tab (or if the Axiom ribbon tab does not display at
all for an administrator), administrators can correct the situation by accessing Axiom Explorer from
the File menu in the Windows Client: File > Launch Axiom Explorer. From here an administrator can
perform actions such as editing their assigned ribbon tab to add the necessary features, or they can
create a temporary task pane to provide access to features such as Security (for example, if the
administrator does not currently have an assigned ribbon tab and cannot access Security to assign
one).

Disabling the Axiom tab for certain users and roles

In rare cases, clients may want to disable the Axiom tab entirely for certain users or roles. Typically this
would only be done if you intend to provide access to all necessary functionality using a custom task
pane instead of a ribbon tab.
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To do this, you would remove AxiomMain.AXL from the Everyone role and instead assign it only to the
users and roles that need it (or you could adjust the configuration on the Everyone role so that the
ribbon tab only displays to administrators). Any users and roles who are not assigned a ribbon tab would
need to be assigned a custom task pane that is set up with all of the functionality they need.

Configuring the Axiom Designer ribbon tab

Axiom Software provides a built-in Axiom Designer ribbon tab to provide various tools to assist in
creating and testing files. By default, this tab is assigned as a startup file for the Everyone role in security,
and configured to only display to administrators. If desired you can do any of the following:
o Customize the contents of the Axiom Designer ribbon tab
« Modify the configuration of the startup file on the Everyone role so that more users have access
to the ribbon tab

o Remove the startup file from the everyone role and then reassign it to other users and roles as
desired

Default behavior

When a new system is created, or when an older system is upgraded, a copy of the Axiom Designer
ribbon tab is placed in the root of the Ribbon Tabs Library (file name: Axiombesigner.AXL). This copy
is listed as a startup ribbon tab for the Everyone role, and is configured as follows:

o Requires Admin is enabled. The Axiom Designer tab will only display to users who are
administrators.

o Requires Sheet Assistant is enabled. The Axiom Designer tab will only display when the active file
is an Axiom spreadsheet file and the Sheet Assistant is also present.

NOTE: You can rename the file and/or move it into a subfolder without breaking the existing startup
configuration.

Changing the startup configuration

If you want to expose the Axiom Designer ribbon tab to other users, you can change the startup
configuration for the file. For example:
e You can leave the file on the Everyone role, but modify the shortcut parameters to remove the
administrator-only requirement. You could allow all users to see it, or you could only require
Sheet Assistant permission so that only "file designers" would see the ribbon tab. For more
information on the available shortcut parameters, see the Security Guide.
o You can remove the file from the Everyone role, but instead assign it to different users and/or
roles. For example you might have a particular role for report writers or other power users, and
you could assign it to that role.

Customizing the contents

If desired you can customize the contents of the Axiom Designer ribbon, by modifying the
AxiomDesigner.AXL file. You can add additional features to the ribbon tab, reorganize the tab, or
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remove existing features. You could also copy the file and create different versions of the tab, and assign
those versions to different users and roles. For more information on creating and editing ribbon tabs,
see Ribbon tabs.

If you modify the default AxiomDesigner.AXL file and then later you decide that you want to restore
the file to its original configuration, a copy of the default file is always available in \Axiom\Axiom
System\Document Templates\Sample Ribbon Tabs. Keep in mind that if you delete the copy in
the Ribbon Tabs Library and then replace it with a copy from the sample folder, then you will need to
reconfigure your security settings to point to the new file (because the startup shortcuts are based on
document ID, not on file name and location). You can instead import the default file over the copy in the
Ribbon Tabs Library; this will retain the document ID.

Configuring the Explorer task pane

Axiom Software provides a built-in Explorer task pane to provide users with quick access to their
favorites, recent items, and all Axiom files that they have rights to access. By default, all users are given
access to this task pane. If desired, you can disable use of this task pane entirely, or restrict access to
certain sets of users.

< Axiom Assistant < Axiom Assistant
My Files My Files
S | 3¢ Favarites < | » 3 Favorites
i:' b =il Recent S |» %Gl Recent
= My Documents £ . :
= || File Groups
File Groups EBudget 2016
g ’ File Group Aliases AL /=] Budget 2017
o " iZ] Budget 2015 = | VE]Capital Requests
= | v iZ]Budget 2016 3
b {2 Budget 2017 Libraries
» ¥Z]Capital Requests » |2l Reports Library
b E Initiatives

Libraries
Example Explorer task pane for an end user

¥ gl Reports Library
¥ [ Table Library
U\nn Data Diagrams Library
b 4 Task Panes Library
¥ [F Ribbon Tabs Library
¥ I Process Definition Library
b E Scheduler Jobs Library
v L Imports Library
» A Exports Library

Axiom System

Example Explorer task pane for an administrator

NOTE: Access to the Explorer task pane is managed using the startup file settings in Security. The
Administer Axiom Explorer permission does not apply to the task pane—it only controls access to
the full dialog accessible from Manage > Axiom Explorer.
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Default behavior

When a new system is created, a copy of the Explorer task paneis placed in the root of the Task Panes
Library (file name: Explorer.AXL). This copy is listed as a startup task pane for the Everyone role, and is
configured to prevent closing.

| General I Permissions | File Groups | Tables | Files | Startup |

Configure documents and task panes to open on login.

Home Page:

Task Panes: += & *

document/NAxiomiTask Panes LibranAExplorerax?nondosable

document/MAxiom\Task Panes LibranA\Workflow.axlTnonclosable

This means that the Explorer task pane is automatically opened when the system is started, for all users.
Users cannot close the task pane, so it is always available. Users do not otherwise have access to the task
pane (meaning, no access is granted to the file itself on the Files tab of Security).

NOTE: You can rename the Explorer.AXL file and/or move it to a subfolder without breaking the
existing startup configuration. You can also edit the shortcut parameters for the startup
configuration to use an alternate tab name, or to allow users to close the task pane if desired.

Disabling the Explorer task pane

If you do not want to use the Explorer task pane at all in your system, then you can edit the startup
settings for the Everyone role in Security, to remove the Explorer task pane from the list of startup task
panes. Once it is removed from the Everyone role, then the task pane will not display for anyone unless
you later manually add it to other roles or users.

If you want to delete the file entirely so that any users with access to the Task Panes Library cannot see it,
you can do so. However, you cannot delete the file if it is open in your current session. You must first edit
the settings for the Everyone role as previously described, and then you must exit the system and log in
again. Now that the Explorer task pane is not open in your session, you can delete the file from the Task
Panes Library.

If you deleted the Explorer.AXL file and then later decide that you want to use it, a copy of the file is
always available in \Axiom\Axiom System\Document Templates\Sample Task Panes.Makea
copy of this file and save it to the Task Panes Library, and then configure access in Security as desired.

Customizing the User Interface Axiom Software | 47



Modifying access to the Explorer task pane

If you want to use the Explorer task pane, but you do not want all users to have access to it, then you
can modify the Security settings as desired.

o First, edit the startup settings for the Everyone role to remove the Explorer task pane from the list
of startup task panes.

o Then, add the Explorer task pane to the startup settings for the applicable roles or users. Select
the Non-closeable check box if you want users to always have access to this task pane. If you
allow the task pane to be closed, remember that users without access to the Task Panes Library
will not be able to reopen the task pane within the current session if they close it.

Customizing the Explorer task pane

The Explorer task pane uses a single item, the Axiom Explorer Tree View from the Command Library.
This control replicates the Axiom Explorer treeview within a task pane. While it is possible to manually re-
create the Explorer look and feel in a task pane by linking to each individual component, using the
control provides advantages such as:

o Access to relevant features. When using the Explorer control, users with the appropriate
permissions gain access to item-specific commands via the right-click menu. For example, users
can right-click a file to open it as read-only, or they can right-click a table to edit the table
structure. If instead an item is linked on a task pane directly, then the item-specific right-click
commands are not available.

o Automatic updates. The Explorer control renders the Axiom Explorer treeview as it currently
exists. If future upgrades introduce new libraries or a changed folder structure, the control will
remain in sync.

It is possible to make a few minor customizations to the Explorer task pane. If desired, you can use
shortcut parameters to hide any of the major sections: My Files, File Groups, Libraries, and Axiom
System Folder. Keep in mind that security permissions are always applied, so users without rights to a
particular section or item will not see it in the task pane. You only need to hide a section if you do not
want it to display for any users, within the task pane.

Configuring the Process task pane

Axiom Software provides a built-in Process task pane to allow the assigned owners of process steps to
easily complete their assigned tasks, and to allow administrators to monitor active processes. This is
applicable if you are using the Process Management feature to define and manage processes.

By default all users are given access to this task pane, however, the task pane will only display to non-
admin users if the user is the owner of an active step in a process. The task pane will display to
administrators if any process is made active. If you never define or activate any processes in your
system, or if a user never has any active tasks in a process, then the task pane will never display.

Default behavior

When a new system is created, a copy of the Process task pane is placed in the root of the Task Panes
Library (file name: Process.AXL). This copy is listed as a startup task pane for the Everyone role, and is
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configured to prevent closing.

| General I Permissions | File Groups | Tables | Files | Startup |

Configure documents and task panes to open on login.

Home Page:

Task Panes: ap it K

document:y/MNAxiom\Task Panes Librany\Explorer.axl? nonclosable
document:/MNadom\Task Panes Libran\Workflow.axlTnonclosable=True

document/AlAxiomiTask Panes Libreny\Process.axl?nondosable=True

This means that the Process task pane will dynamically display depending on whether any Process
Management processes are ever made active. If they are, then administrators will always see the task
pane if there are any active processes, and non-admin users will only see the task pane when they are
the assigned owner of an active step in a process. Users do not otherwise have access to the task pane
(meaning, no access is granted to the file itself on the Files tab of Security).

NOTE: You can rename the Process . AXL file and/or move it to a subfolder without breaking the
existing startup configuration.

Disabling the Process task pane

If you do not want to use the Process task pane at all in your system, then you can edit the startup
settings for the Everyone role in Security, to remove the Process task pane from the list of startup task
panes. Also, if you want to delete the file entirely so that any users with access to the Task Panes Library
cannot see it, you can do that too. However, remember that users will only see the task pane when it is
relevant to them, so we recommend leaving the configuration as is in case you change your mind in the
future and decide to use Process Management.

If you deleted the Process . AXL file and then later decide that you want to use it, a copy of the file is
always available in \Axiom\Axiom System\Document Templates\Sample Task Panes.Makea
copy of this file and save it to the Task Panes Library, and then configure access in Security as desired.

Customizing the Process task pane

The Process task pane uses a single item, the User Process View from the Command Library. This
command does not have any shortcut parameters to configure its behavior.

If desired, you can include this control in a custom task pane along with other items as desired, and use
that custom task pane instead of the built-in task pane. If you do this, you should remove the built-in
task pane from the Everyone role as described previously, and instead configure security for your
custom task pane as needed.
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